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SP-12 Librarian for E-mu System’s SP-12™
and SP-12 Turbo digital drum machine lets
you save and load sounds and sequences in
a fraction of the time by using your Apple®

Macintosh® computer.

Sounds, songs, and song segments can be
named to help organize your work. Also, the
SP-12 Librarian’s Sound Catalog keeps
track of your entire SP-12 sample library, so
you don’t have to!

And of course, the Sound Catalog can be
printed at any time to document your library.
So can sound files and song files, too.

The SP-12 Librarian for the Macintosh.
We’re putting power in your SP-12.
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Welcome
Years after its initial release, E-mu System’s SP-12 is still one of the
best drum machines around. The combination of great sounds and
ease of use, for which E-mu is famous, has made the SP-12 a
noteworthy drum machine even by today’s standards.

In spite of the SP-12’s virtues, it was generally accepted that
samples and sequences would be saved on a Commodore 1541
floppy disk drive. Although the 1541 is reliable and inexpensive (as
disk drives go), it is also painfully slow.

Welcome to the SP-12 Librarian, by Water's Edge Software.

The SP-12 Librarian lets you use the power of your Macintosh to
save sounds and sequences in a fraction of the time it takes a 1541
disk drive. Numerous other SP-12 Librarian features help you
organize your SP-12’s information, and present it in a professional
manner.

About This Manual
This manual is a comprehensive user’s guide for the SP-12 Librarian.
It details the installation and operation of the SP-12 Librarian, as well
as providing useful hints.

Several assumptions were made when writing this manual:
• You are familiar with your Macintosh computer (hardware) and

related peripherals, such as disk drives, printer (optional), and
MIDI interface.

• You are familiar with the use of your Macintosh, and are
accustomed to the various terms used to describe Macintosh
operations, such as “selecting”, “clicking” and “dragging.”

• You are familiar with your SP-12 drum machine.

Although it’s possible to figure out how to use the SP-12 Librarian
without ever reading the User’s Manual, we suggest that you do read
it anyway. If it does nothing else, the User’s Manual will show you
what a nifty program the SP-12 Librarian really is!

Throughout this manual, the term SP-12 refers to both the standard
SP-12 drum machine (with 1.2 seconds of sampling memory), and
the SP-12 Turbo (with 5 seconds of memory), unless otherwise
stated. For all intents and purposed, the only difference between the
two machines is the amount of memory contained by the SP-12. The
term sequence refers to the SP-12’s combined song and segment
memory (100 songs, 100 segments).

System Requirements
To use the SP-12 Librarian, you need:

• A Macintosh computer (512KE or higher, excluding the
Macintosh Portable, PowerBook, or Duo)

• The Macintosh must have two floppy disk drives, or a hard
disk

• Printer for the Macintosh (optional)
• A MIDI interface for your Macintosh with simultaneous MIDI in

and MIDI out
• 2 MIDI cables
• SP-12 drum machine
• The SP-12 Librarian program and User’s Manual

Hardware Setup
The SP-12 Librarian, while communicating with the SP-12,
simultaneously processes incoming and outgoing MIDI information.
Therefore, it requires two MIDI connections to operate.

Use the appropriate cables to connect your SP-12 to your
Macintosh’s MIDI interface. Although most 5-pin DIN cables such as
those from Radio Shack will work, you should use high quality MIDI
cables available from your music store.

There are many ways to set up a MIDI network for various needs.
The simplest is illustrated below:

Out

Out

In

In

Macintosh MIDI SP-12
Interface

If you decide to incorporate a more sophisticated MIDI network (as
most musicians will), you should keep two things in mind whenever
the SP-12 is working with the SP-12 Librarian:

1. The SP-12’s “MIDI in” should receive only the Macintosh’s
“MIDI out”, and nothing else.

2. The Macintosh’s “MIDI in” should receive only the SP-12’s
“MIDI out”, and nothing else.

Installing the SP-12 Librarian
SP-12 Librarian arrives on one 800K floppy disk (or a 400K disk if
requested). The disk contains the SP-12 Librarian program and a
System folder. The SP-12 Librarian is not copy-protected. To install
the SP-12 Librarian, do the following:

1. Make a backup copy of the SP-12 Librarian disk, and store it in
a safe place. The backup disk must bear Water's Edge
Software’ copyright notice.

If you only have 400K disk drives:
• You are now ready to use the SP-12 Librarian. Restart your

Macintosh using the SP-12 Librarian disk as a startup disk.

If you only have 800K disk drives:
• You are now ready to use the SP-12 Librarian. Restart your

Macintosh using the SP-12 Librarian disk as a startup disk.

If you have a Hard Disk:
1. Start up your Macintosh using your hard disk as the startup

disk.
2. Insert the SP-12 Librarian disk.
3. Drag the SP-12 Librarian icon from the floppy disk to your hard

disk.
4. Eject the SP-12 Librarian floppy disk. You are now ready to use

the SP-12 Librarian.
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Disk Optimization
This section deals with creating extra space on your 800K floppy
disk. If you are using 400K floppy disks only, or if you have a hard
disk, you can skip this section. Disk optimization is optional reading.

It is advantageous to have as much free space as possible on your
startup disk (up 192K) for several reasons:

• Printing a document temporarily requires about 15K
• The startup disk is the ideal place to keep your Sound Catalog

(explained later in this manual). The average size of a Sound
Catalog is about 10K.

• The SP-12 Librarian uses up to 192K of your startup disk (if
available) to ensure that a sound or sequence file is not
damaged when it is updated by the SP-12. This process is
explained later in the manual.

If you only have 800K disk drives:
• If you are using a Macintosh 512KE, Plus, SE, or SE/30, you can

remove the following files from your System folder by dragging
them to the trash: Color, Monitors, and Startup Device.

• If you want to, you can use Apple’s “Font/DA Mover” to remove
desk accessories from the System File. Font/DA Mover is
detailed in the Macintosh Utilities User’s Guide. (Note that the
System file must contain at least 1 desk accessory.) Your
System file includes the following desk accessories:

Alarm Clock Control Panel
Calculator Key Caps
Chooser Scrap Book

If you do not have a printer, remove the Chooser desk accessory.
Also remove the ImageWriter file from the System folder by
dragging it to the trash.
If you removed the Control Panel desk accessory, also remove the
following files from your System folder by dragging them to the
trash: General, Keyboard, Key Layout, Mouse, and Sound.
If you removed the Scrap Book desk accessory, also remove the
Scrap Book file from the System folder by dragging it to the
trash.

• If you want to, (or if you are not going to print any SP-12 files)
you can use Apple’s “Font/DA Mover” to remove unwanted fonts
from the System file on your SP-12 Librarian disk. You can
remove any or all the “New York” font sizes. You can also
remove all “Geneva” font sizes except 9 and 12 points.

If you have a Hard Disk:
• No disk optimization is required. You may, however, want to

make sure you are using the latest version of the System file and
The Finder. Contact your local Apple dealer to determine the
latest system version, and to possibly obtain an “Apple
Macintosh System Update” kit.

Summary of SP-12 Librarian Features
General
• SP-12 data is saved on Macintosh disks (floppies, hard disks,

optical disks, removable disks, just about anything)
• SP-12 Librarian saves and loads files a lot faster than a 1541 disk

drive.
• SP-12 Librarian files are compact. An average SP-12 Turbo sound

file is only 140K. This means that a single 800K floppy can hold
about 5 sound files, or a few dozen huge sequence files.
  Don’t bother using file compression applications since the gains
are minimal.

• Sounds, sequences, and other files can all be on the same disk.
The 1541 disk drive, on the other hand, only lets you have one file
per floppy. Also, the 1541 needs two floppies to store the entire
sample memory of an SP-12 Turbo!

• The SP-12 Librarian’s “Fail Safe” file management makes sure you
don’t lose an existing file if something goes wrong while you are
updating it with new SP-12 information.

• Up to 4 sound or sequence files may be open simultaneously, in
addition to the Sound Catalog.

• Each SP-12 Librarian disk is inspected for computer viruses before
leaving our facility.

• No copy protection means you don’t have to pay for a backup
disk, or wait for one to arrive in the mail. It also means you won’t
have hassles when installing the SP-12 Librarian on your hard disk.
We remind you, making a copy of the SP-12 Librarian for a
purpose other than making your own backup is highly illegal. It also
directly hurts us, the people that made the SP-12 Librarian
possible. Please don’t pirate software!

• SP-12 Librarian is MultiFinder and System 7 compatible.
• SP-12 Librarian is memory efficient, running with as little as 180K.
• The SP-12 Librarian works with most “screen saver” programs.
• Monochrome (black and white), grey-scale, and color monitors are

supported, as well as Macintoshes with multiple monitors.

Sound Files
• Each sound can be named. This includes ROM samples too!
• The names of all 32 sounds can be displayed simultaneously. The

sounds are organized into banks, just like your SP-12.
• Each sound indicates if it is a RAM or ROM sample.
• Each sound can be classified in a manner that suits you best (such

as: Kick Drums, Toms, Electric Toms, Cymbals, Hi-Hats, etc.)
• The SP-12 Librarian can remember a list of predefined sound

categories. This list can be used to standardize and simplify the
classification of future sounds.

• Each sound’s Name, Category, output Channel number, Mix Level,
Tune/Decay selection and value, and Sample Time can be
displayed simultaneously.

• Each sound’s output Channel number, Mix Level, and Tune/Decay
selection and value can be edited using the SP-12 Librarian.

• You can alter the tuning and decay of ROM sounds beyond the
range which is possible by using the SP-12’s control panel.

• Sound file information is used to compile the Sound Catalog, an
organized index of your entire SP-12 sample library.

Sequence Files
• Each song and segment can be named.
• Both songs and segments are viewed simultaneously in the same

window.

Sound Catalog
• The Sound Catalog is a comprehensive listing of your SP-12

sample library. It’s like an index to your samples.
• The Sound Catalog can be sorted by sound file. This listing is best

suited for determining the contents of each sound file.
• The Sound Catalog can also list the samples by category. This

listing is best suited when looking for a particular type of sample.
For instance, all the “Snare” samples would be grouped together,
indicating where each sample can be found.

• The Sound Catalog can remain open in addition to 4 sound or
sequence files. This lets you switch back and forth between sound
files without having to open and close the Sound Catalog.

Printing
• Sound files, sequence files, and the Sound Catalog can all be

printed. The SP-12 Librarian produces professional results,
especially if you have a laser printer.

• SP-12 Librarian lets you decide which font and font size is used for
printing reports.
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The First Time You Use The SP-12 Librarian
The SP-12 Librarian assumes that you are using a 1 megahertz MIDI
interface attached to the Macintosh’s modem port, since this is the
most common configuration. If this describes your MIDI setup, you
may skip the remainder of this section.

Do the following steps to set up the SP-12 Librarian to work with your
MIDI setup:

1. If you have not already done so, double-click the “SP-12
Librarian” icon to start the program.

2. Select Preferences from the Edit menu.
3. Click the MIDI Interface icon on the left side of the window
4. Select the correct port by clicking the printer or modem icon.

This represents the serial port to which your MIDI interface is
attached.

5. Select the correct MIDI interface speed (.5 MHz, 1 MHz, or
2 MHz). Most MIDI interfaces operate at 1 MHz. If you are
unsure of your interface’s speed, contact the interface’s
manufacturer or the place where you purchased your interface.

5. Close the Preferences window. The SP-12 Librarian is now
ready to use. All settings are saved automatically, and will be
used each time you start the SP-12 Librarian.

Using The SP-12 Librarian With MultiFinder
The SP-12 Librarian works with Finder and MultiFinder (available on
Systems 5 and 6), providing your startup disk is equipped with
MultiFinder and your Macintosh has enough memory. If you are
uncertain about whether you have MultiFinder or not, ask your Apple
dealer. As a general rule, you need at least 2 megabytes of memory
(RAM) to make use of MultiFinder. For more information about
MultiFinder, please read the applicable section in your “Macintosh
Owner’s Guide.”

Using The SP-12 Librarian With System 7
SP-12 Librarian is System 7 compatible, although it does not support
Apple Events and does not offer Balloon Help.

Color Monitors and Multi-Monitor Setups
SP-12 Librarian runs on a Macintosh with any monitor (ie: black and
white, gray-scale, color, millions of colors, etc.) It also accommodates
setups that use two or more monitors.

How Much Memory Is Enough?
If you are running SP-12 Librarian under MultiFinder (System 5 and
6) or System 7, you can specify how much memory the librarian
should use. This feature is available in the Get Info window.

The SP-12 Librarian, when working with MultiFinder or System 7,
automatically reserves sufficient memory to run at peak performance
under most situations. If you want to change the amount of memory
the SP-12 Librarian uses (to allocate more memory to critical
applications such as your sequencer), do the following:

1. Quit all applications and return to The Finder.
2. From The Finder, click the SP-12 Librarian icon once.
3. Select the File menu’s Get Info command.
4. At the bottom of the info window, you will find an “Application

Memory Size” box if you are using System 5 or 6, or a
“Preferred Size” box if you are using System 7.

This is the actual amount of memory you are allowing the
SP-12 Librarian to consume. Set its value to desired amount,
as described below.

5. Click the info window’s close box, or select the File menu’s
Close command.

384k is enough memory to run the SP-12 Librarian at peak
performance with a large Sound Catalog file, and the maximum
number of open documents. Unless you have an unusually large
Sound Catalog, this will be enough.

256k will let you work with the maximum number of open documents,
and a Sound Catalog that has about 275 sounds. You will notice a
slight decrease in performance.

180k will let you open a single sound file or sequence file at a time,
then load and save the SP-12’s data.
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Learning The SP-12 Librarian
This section, Learning The SP-12 Librarian, deals briefly with saving
files, loading files, and compiling the Sound Catalog. It is a summary
of information found throughout the User’s Manual, and is intended to
get you running in the shortest possible time.

Learning The SP-12 Librarian contains key concepts that must be
understood when using the SP-12 Librarian. We recommend that all
users read this section. If you want a more detailed explanation of a
particular item or feature, read the corresponding section in Using
The SP-12 Librarian.

The SP-12 Librarian maintains five different types of files, as
illustrated below. Each file, when open, is displayed as a single
window, so you can consider the words file and window to be
synonymous. The five types of SP-12 Librarian files are:

12SP- 12SP- 12SP- 12SP-
Blank Sound Sequence Damaged Sound
File File File File Catalog

Blank File: Before you can save the SP-12’s sound or sequence
data, a new file must be created. This file remains blank (empty)
until SP-12 information is saved in that file.

Sound File: Contains a set of SP-12 sounds (up to 32) including
their names and other related information. If you save sounds in a
blank file, the blank file will become a sound file.

Sequence File: Contains a set of SP-12 sequences (100 songs and
100 segments) including their names. If you save sequences in a
blank file, the blank file will become a sequence file.

Damaged File: If something goes wrong while saving SP-12 data to
a blank file, it will become a Damaged file. You can treat a
damaged file the same as you would a blank file: you can drag it to
the trash, or save SP-12 data in that file to make it become a
sound or sequence file.

Sound Catalog: Contains the entire SP-12 Sound Catalog
information. Note that the catalog is comprised of names, and not
the actual sound samples. You can think of the Sound Catalog as
an index to your sample library.

Creating A New File
Before you can save any of the SP-12’s data on the Macintosh, you
have to create a new file. To create a new file, do the following:

1. If you have not already done so, double-click the “SP-12
Librarian” icon to start the program.

2. If you are going to store your sounds and/or songs on floppy
disks, insert the appropriate floppy disk in the disk drive.

3.  Choose New from the File menu. A dialog asking for a “New
File Name” is displayed. Type in a file name, but don’t click
Save just yet.

4. If you are using floppy disks only, select the floppy that isn’t
your startup disk (if necessary) so that the new file is not
created on your startup disk.

5. Click the Save button to save the file. You have just created a
new (empty) file. You may now continue to Saving Sounds or
Songs.

Saving Sounds or Songs
The SP-12 Librarian lets you save the SP-12’s sound or sequence
data to the active window’s file.

If you are creating a new file, read Creating A New File
immediately preceding this section.

If you are in The Finder, double-click the file in which the SP-12’s
data will be saved.

If you are in The SP-12 Librarian and the required file is not visible,
you can use the Windows menu to activate the required window (if
it is open), or use Open in the File menu to open the required file.
(Note that since a maximum of 4 sound or sequence files can be
open simultaneously, you may have to close one of the other
windows first.)

To save the SP-12’s sounds or sequences on the Macintosh, do the
following:

1. Make sure the active window is the one you want to use to save
the SP-12’s data.

2. Select SP-12 Link in the Windows menu. This establishes a link
between the SP-12 and the Macintosh (it gets the two talking to
each other on MIDI). An “SP-12 Link” dialog appears with the
message “Waiting for commands from SP-12.” From this point
onwards, the Macintosh will get its orders (commands) from the
SP-12.

3. On the SP-12’s control panel, press the Cassette/Disk button to
activate that module.

4. To save sounds, type 32 in the SP-12’s numeric pad.
To save sequences, type 31.

5. The SP-12 displays the message “Insert Disk and Press Enter.”
Press the SP-12’s Enter button. The SP-12 begins saving its
data on the Macintosh.

Notice that the SP-12 treats the Macintosh just like a 1541
disk drive, only considerably faster. All the SP-12’s
Cassette/Disk operations are the same when using the SP-12
Librarian as with the 1541 disk drive, except that the first digit of
each operation is a “3” instead of a “2”.

6. When the SP-12 has finished savings its data, click the Cancel
button on the SP-12 Link dialog. This concludes the link
between the SP-12 and the Macintosh. You may now type in
the names of your sounds, or sequences. For more information,
see Using a Sound File and Using a Sequence File in the
“Using the SP-12 Librarian” section.

Loading Sounds or Songs
The SP-12 Librarian lets the SP-12 load sound or sequence data
from the active window’s file.

If you are in The Finder, double-click the sound or sequence file
you wish to load into the SP-12.

If you are in The SP-12 Librarian and the required file is not visible,
you can use the Windows menu to activate the required window (if
it is open), or use Open in the File menu to open the required file.
(Note that since a maximum of 4 sound or sequence files can be
open simultaneously, you may have to close one of the other
windows first.)

To load sounds or sequences from the Macintosh into the SP-12, do
the following:

1. Make sure the active window is the one you want to load into
the SP-12. (It must be a sound or sequence file.)

2. Select SP-12 Link in the Windows menu to establishes a link
between the SP-12 and the Macintosh.

3. On the SP-12’s control panel, press the Cassette/Disk button to
activate that module.

4. To load sounds, type 35 in the SP-12’s numeric.
To load sequences, type 33.

5. The SP-12 displays the message “Insert Disk and Press Enter.”
Press the SP-12’s Enter button. The SP-12 begins loading its
data from the Macintosh.

6. When the SP-12 has finished loading its data, click the Cancel
button on the SP-12 Link dialog to terminate the SP-12 link.
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Creating The Sound Catalog
The SP-12 Librarian’s Sound Catalog is an index of your SP-12’s
sample library. It contains the following information for each sample:
Sample Name, Location (ie: the SP-12 button, such as “User 1” or
“Tom 3”), the File Name in which the sample is located, the sample’s
Category (ie: Toms, Cymbals, Effects, etc.), and the sample length in
seconds. It does not contain the actual sample data.

To create the Sound Catalog, do the following:
1. Make sure the active window is the one you want to add to the

Sound Catalog. (It must be a sound file.)
2. Select Add Sounds To Catalog in the Catalog menu.
3. The SP-12 Librarian responds with the dialog:

Can’t find “SP-12 Catalog” file. Do you want to look for it, or
create a new Catalog?

Click the New button, since you want to create the Sound
Catalog.

4.  A dialog asking for a “New Catalog Name” is displayed. The
name “SP-12 Catalog” is the default, but you can change it if
you want. Select the disk and folder where you want to create
the catalog file (the SP-12 Librarian will remember it).

5. Click the Save button to create the Sound Catalog. The active
sound file’s information is automatically appended to the Sound
Catalog.

What Should You Read Next?

Using the SP-12 Librarian provides complete details for SP-12
Librarian users. First, the librarian’s menus are explained. Though
the SP-12 Librarian’s menus are fairly straight forward, this section
includes helpful hints that will make using the SP-12 Librarian a little
easier.

The sections Using a Sound File, Using a Sequence File, and
Using The Sound Catalog detail the use of their respective windows
within the librarian. You should at least glance through this section.

Behind The Scenes gives you a little background on how the SP-12
Librarian does its magic. Miscellaneous technical details are located
in this section. By glancing at the titles within this section, you will be
able to tell if you want to read certain parts or not.

Messages And Errors list all the messages and errors you will ever
(and probably never) come across in the SP-12 Librarian. You will
likely use this as a reference only.

The Software License Agreement and Limited Warranty are
legally binding contracts between you, the end user, and Water's
Edge Software. This is a copy of the agreement and warranty found
on the sealed disk package delivered with the SP-12 Librarian.

The Registration section contains a Registration Form that you
should mail in as soon as possible. It entitles you to special benefits.
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Using The SP-12 Librarian
This section details all aspects of SP-12 Librarian use, starting with
the menus. In-depth explanations for sound file windows, sequence
file windows, and the Sound Catalog can be found later in this
section.

File  menu:  New
New is used to create a new (blank) file. If you want to create a new
file and New is dimmed, close one of the open sound or sequence
windows, since only a total of 4 sound or sequence windows can be
open simultaneously (including blank and damaged files).

When New is selected, a dialog asking for a “New File Name” is
displayed. Type in the desired name, select the disk and folder in
which the file will be created, then click Save.

The SP-12 Librarian assumes that you want to save information in
the blank file right away, so it automatically opens the SP-12 Link
dialog and waits for commands to be entered from the SP-12. You
can turn this feature off as described in the Preferences section.

The illustration below shows a typical Macintosh’s screen after
selecting New:

✓ Tips…
• If you are using floppy disks only, don’t create new files on the

SP-12 Librarian startup disk.
• If you are saving your sound files on floppy disks, you may want to

adopt a naming convention that will allow you to locate your
samples more easily. For example, you can number your sound
disks and prefix each sound file’s name with the disk number
where it is located, such as O1-Steve’s Killer Toms. If you do this,
the Sound Catalog will indicate not only which file contains the
sample you’re looking for, but also the disk. The same principle
works with folders if you are saving your samples on a hard disk
and want to separate your sound files into different folders.

• A blank file consumes 5K on a disk, so it’s a good idea to delete
blank files if you’re not using them.

File  menu:  Open
Open is used to open an existing sound file, sequence file, blank file,
or damaged file. If you want to open a file and Open is dimmed, close
one of the sound or sequence windows that are already open, since
only a total of 4 sound or sequence windows can be open
simultaneously, including blank and damaged files.

When Open is selected, a dialog of available files is displayed which
lets you select the required file. Note the following:

• If you want to open the Sound Catalog, use Show Catalog in the
Catalog menu.

• Only sound files, sequence files, blank files, damaged files, and
folders are displayed by the Open dialog.

• A file’s name will not be shown in the Open dialog if that file is
already open.

• A file’s name will not be shown in the Open dialog if a file using the
same name is already open. For example, if you have a file called
“Steve’s Sounds” open, you can’t open another file called “Steve’s
Sounds”, even if it is on another disk. (This is to help avoid
confusion.) Besides, it’s a good idea not to use the same name for
multiple files.

File  menu:  Close
Close is used to close an open file. The same result can be attained
by clicking the window’s Close Box, situated on the left side of the
window’s title bar.

If any changes have been made in the file, a dialog asks you if you
want to save the changes before closing the file.

File  menu:  Save
Save is used to save any changes made in the active window to the
corresponding file on the disk. It’s a good idea to save your changes
every 15 minutes or so, just in case a blackout occurs. If the active
window has no changes to be saved, Save is dimmed and cannot be
selected.

File  menu:  Save As
Save As is used to make a copy of the active window using another
name, without affecting the original file. Say, for example, you loaded
your SP-12 with a sequence file called “Steve’s Song” then added an
extra chorus. You then want to save the new version of the song on
your Macintosh without losing the original file. You can use Save As
to save a copy of “Steve’s Song” as “Steve’s Song, version 2” (or
some other appropriate name).

When Save As is selected, a dialog is displayed asking for a new file
name. Type in the desired name, select the desired disk and folder,
then click the Save button. The active window is renamed to your
new file name. The original file is closed, and you are now working
with your new copy.

✓ Tips…
• If you are using floppy disks, don’t save the new file on the SP-12

Librarian startup disk.
• You should stick with the same file naming conventions you

decided upon when reading about the New command. This is
especially true with sound files.
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File  menu:  Page Setup
Page Setup lets you define a number of printing features, such as the
size of paper you print on and the orientation of the document on the
page. Details can be found in your “Macintosh Owner’s Guide.” Page
Setup applies to the active window only. The active window must be
a sound file, sequence file, or Sound Catalog. Each file has its own
Page Setup settings.

Before you print a file the first time, use Page Setup to set the
printing features for the active window. These settings are saved with
the file and are used whenever the file is printed.

If you have several printers, or if you switch printers (such as
changing from an ImageWriter to a laser printer), read the section
about The Chooser in your “Macintosh Owner’s Guide.”

File  menu:  Print
Print lets you print the active window’s file. The active window must
be a sound file, sequence file, or Sound Catalog. When you select
the Print command, a dialog appears which lets you set various
printing options on your printer. Your printer’s manual should
describe these options in detail. Click the OK button to start printing.

The print settings are used only for printing, and are not saved as
part of your file.

✓ Tips…
• If you are using an ImageWriter (or some other dot-matrix printer),

you can achieve a higher quality of printing by selecting a report
font that is twice the size you really want, then reducing the
document by 50% (see Report Font in the Edit menu’s Preferences
for more details). Also, use cut sheets instead of tractor-fed paper
to produce a crisper image.

File  menu:  Quit
Quit is used to quit the SP-12 Librarian and return to The Finder. All
open windows are closed. As each window is closed (and only if
changes have been made), a dialog asks you if you want to save the
changes before quitting.

Edit menu: Undo, Cut, Copy, Paste,
Clear
The first five items in the Edit menu, namely Undo, Cut, Copy, Paste,
and Clear, work as described in your “Macintosh Owner’s Guide.”

File  menu:  Preferences
You can set various preferences for the SP-12 Librarian. These
settings are remembered and used by the librarian until you change
them. Select a preference by clicking one of the icons along the left
side of the window. The right side shows you the available settings
for the chosen preference. When you close the Preferences window,
all the settings are automatically saved.

Midi Interface
MIDI Interface is used to tell the SP-12 Librarian about your MIDI
system. The illustration below shows the MIDI Interface preference:

The Port icons select which serial port is used (ie: the one that is
connected to your MIDI interface). Most MIDI interfaces operate at
1 MHz. If you are not sure of your interface’s speed, contact the
interface’s manufacturer or the place where you purchased your
interface.

Auto-Open Link
Auto-Open Link is used to automatically open the SP-12 Link under
certain circumstances (see the Windows menu’s SP-12 Link for
details on the link).

Please note that the SP-12 Link does not open when you first start
the SP-12 Librarian, regardless of the setting. The illustration below
shows the Auto-Open Link preference:

By selecting the appropriate check box, you can establish the SP-12
Link under any or all of the following conditions…
• After creating a new file
• After opening a sound file
• After opening a sequence file
• After opening a blank or damaged file
• When a command is entered at the SP-12

Note: If you are running a low-end Macintosh, such as a Macintosh
Plus with only floppy disks, then you may have problems with the
“When a command is entered at the SP-12” option. When you enter
a command at the SP-12’s control panel, it sends a “disk status”
command to the SP-12 Librarian. If the librarian does not open the
link and return a status to the SP-12 quickly enough, then the SP-12
assumes that no disk is connected.

If this happens, re-try the command at the SP-12’s control pannel
and the link will be established.
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Auto-Close Link
Auto-Close Link is used to automatically close the SP-12 Link under
certain circumstances (see the Windows menu’s SP-12 Link for
details on the link). The illustration below shows the Auto-Close Link
preference:

By selecting the appropriate check box, you can terminate the SP-12
Link under any or all of the following conditions…
• When a process is canceled at the SP-12
• When any process is completed (ie: any SP-12 Cassette/Disk

command)
• After reading from a sound file
• After saving sounds
• After reading from a sequence file
• After saving sequences

Report Font
Report Font is used to select the font family and font size that is used
to print all SP-12 Librarian documents. The selection made in the
Report Font preference applies to all files, not just the active window.
The illustration below shows the Report Font preference:

✓ Tips…
• If you are using an ImageWriter (or some other dot-matrix printer),

you can achieve a higher quality of printing by selecting a report
font that is twice the size you really want, then reducing the
document by 50%. If you do this, make sure the 1/2 size font is
also available. For example, Geneva 18 can be used because it’s
1/2 size, Geneva 9 also exists. However, Geneva 14 can’t be used
because Geneva 7 does not exist. For added font crispness, use
“Best” print quality and cut sheets instead of tractor-fed paper.

• Be careful not to choose a font size that is too big. If you do, your
report will be truncated to fit onto a single page.

Catalog  menu:  Show Catalog
Show Catalog activates the Sound Catalog and brings it to the front.
If the Sound Catalog is already the active window, a check mark ( )
appears beside the Show Catalog command.

If the catalog isn’t open, Show Catalog attempts to locate and open
the Sound Catalog. The SP-12 Librarian remembers the location
(disk and folder) and file name of the catalog from the last time it was
used. If the Sound Catalog can’t be found, the following dialog is
displayed:

The Find button displays an Open dialog that lets you look in disks
and folders for the Sound Catalog. Only folders and Sound Catalogs
are displayed in the Open dialog.

The New button displays a dialog asking for a “New Catalog Name.”
If you want to create a new Sound Catalog, do the following:

1. SP-12 Librarian assumes that the catalog will be named “SP-12
Catalog”, but you can rename it if you wish.

2. Select the disk and folder (if necessary) where you want the
catalog to be located. The SP-12 Librarian remembers the
name and location of the catalog for future reference.

3. Click the Save button to create the new Sound Catalog.

✓ Tips…
• If you are using floppy disks and you don’t have a hard disk, place

the Sound Catalog on your startup disk. That way, the SP-12
Librarian will be able to find the Sound Catalog automatically next
time you select Show Catalog or Add Sounds To Catalog.
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Catalog  menu:  Add Sounds To
Catalog
Add Sounds To Catalog is used to add the active window’s sample
information (but not the actual samples) to the Sound Catalog. The
Sound Catalog is updated with RAM sample information only (not
ROM). This command is dimmed and cannot be selected if the active
window is not a sound file.

If the Sound Catalog is not already open, Add Sounds To Catalog
attempts to locate and open the Sound Catalog. The SP-12 Librarian
remembers the location (disk and folder) and file name of the
catalog, from the last time it was used. If the Sound Catalog can’t be
found, the following dialog is displayed:

The Find button displays an Open dialog which lets you check other
disks and folders for the Sound Catalog. Only folders and Sound
Catalogs are displayed in the Open dialog.

The New button displays a dialog asking for a “New Catalog Name.”
If you want to create a new Sound Catalog, do the following:

1. SP-12 Librarian assumes that the catalog will be named “SP-12
Catalog”, but you can rename it if you wish.

2. Select the disk and folder (if necessary) where you want the
catalog to be located. The SP-12 Librarian remembers the
name and location of the catalog for future reference.

3. Click the Save button to create the new Sound Catalog.

✓ Tips…
• If you are using floppy disks and you don’t have a hard disk, place

the Sound Catalog on your startup disk. That way, the SP-12
Librarian will be able to find the Sound Catalog automatically next
time you select Show Catalog or Add Sounds To Catalog.

• If you make any changes to the sound file (renaming the file,
adding or deleting samples, renaming samples, changing sample
categories, or changing sample locations), use Add Sounds To
Catalog to update the Sound Catalog with the new information.

• If you rename a sound file that has been previously added to the
Sound Catalog, the catalog will still contain sample information
referring to the old file name. You must delete the individual
samples referencing the old file name from the Sound Catalog, as
described in Using The Sound Catalog.

Catalog  menu:  Define Category
Define Category maintains a list of categories that can be used to
classify your sounds. Although you can categorize sounds without
first defining the category, this list helps you standardize your
categories. The Define Category dialog is illustrated below:

To add a new category, type the category and click the Add button.
The category can be up to 12 characters long, including spaces.

To delete a category, click the required category then click the
Delete button. This only deletes the category from the SP-12
Librarian’s category list. It does not delete each occurrence of that
category from sound files or the Sound Catalog.

To change a category, first delete the old category as described
above, then add the new category.

The category list is always sorted alphabetically, and is not case
sensitive (ie: it treats upper and lower case letters the same way).
Any changes made to the category list are saved automatically. The
category list is available each time you use the SP-12 Librarian.

✓ Tips…
• For consistency, make sure each entry in the list is typed the same

way. Use either upper case (HI-HAT) or mixed case (Hi-Hat)
letters.

• You can use the up arrow and down arrow to scroll through the list.

Catalog  menu:  Set Category
Set Category uses the category list maintained by the Define
Category command. If your insertion point is in the category field of a
sound window (the sound window must be set to “View All” by the
Windows menu), Set Category is enabled. Otherwise, it is dimmed
and cannot be selected.

Using Set Category is the same as typing the category yourself,
except that it’s much quicker and it ensures that you don’t make
typographical errors. The Set Category dialog is illustrated below:

To select a category, click the category in the list then click the OK
button, or you can just double-click the selection in the list.

✓ Tips…
• The Set Category dialog remembers its position on the screen. You

may want to move it out of the way to see the sound’s name and
category columns.

• The Set Category dialog also remembers the last item selected, so
you can choose the previously selected category by just pressing
Enter or Return.

• You can use the up arrow and down arrow to scroll through the list.
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Catalog  menu:  Sort By File
Sort By File is used to sort the Sound Catalog by sound file. The
Sound Catalog window must be active to select this command. A
check mark ( ) appears to the left of Sort By File  if the Sound
Catalog is sorted this way.

The Sound Catalog, when sorted by file, is best suited for
determining the contents of each sound file.

The Sound Catalog remembers the way it was sorted when you quit
the SP-12 Librarian or when the Sound Catalog is closed. The next
time you open the Sound Catalog, it will be sorted the same way.

Catalog  menu:  Sort By Category
Sort By Category is used to sort the Sound Catalog by each sample’s
category. The Sound Catalog window must be active to select this
command. A check mark ( ) appears to the left of Sort By Category  if
the Sound Catalog is sorted this way.

The Sound Catalog, when sorted by category, is best suited for
finding a particular type of sample. For instance, all the “Snare”
samples would be grouped together, indicating where each sample
can be found.

The Sound Catalog remembers the way it was sorted when you quit
the SP-12 Librarian or when the Sound Catalog is closed. The next
time you open the Sound Catalog, it will be sorted the same way.

Windows  menu:  Available
The first four items in the Windows menu are initially Available and
dimmed, and cannot be selected. When a sound file, sequence file,
blank file, or damaged file is opened, its name appears in this place.

These commands are a quick way of activating a window that may
not be visible. So, instead of having to click on an inactive window,
you can select the desired name in the Windows menu. A check
mark ( ) appears to the left of the active window.

Windows  menu:  View Names
A sound file can be displayed in two different ways: (1) sample
names only, or (2) all information. View Names is used to display
only the sample names for the active window. A sound window must
be active to select this command. A check mark ( ) appears to the
left of View Names if the active sound file is displayed this way.

The View Names option is best suited to determine the names of all
the sounds in a sound file, as illustrated below:

Each sound file remembers the way it was displayed when you quit
the SP-12 Librarian or when the sound file is closed. The next time
you open that sound file, it will be displayed the same way.

Windows  menu:  View All
A sound file can be displayed in two different ways: (1) sample
names only, or (2) all information. View All is used to display all the
available information for the active window. A sound window must be
active to select this command. A check mark ( ) will appear to the left
of View All if the active sound file is displayed this way.

The View All option is best suited to view all the details of a sound
file, as illustrated below:

Each sound file remembers the way it was displayed when you quit
the SP-12 Librarian or when the sound file is closed. The next time
you open that sound file, it will be displayed the same way.
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Windows  menu:  SP-12 Link
SP-12 Link is used to establish a link between the SP-12 and the
Macintosh (it gets the two talking to each other on MIDI). The SP-12
Link is established for a single file at a time. You can equate this file
with a 1541 disk, since the SP-12 reads from, or writes to this file in
pretty much the same way it works with a 1541 disk drive, only a lot
faster.

The active window must be a sound file, song file, blank file, or
damaged file. From the SP-12’s point of view, the active window is a
disk in a 1541 disk drive, and ready for action.

When it comes to sending and receiving its sound and sequence
data across MIDI, the SP-12 insists on being in charge (it won’t let an
external MIDI device tell it what to do). When you select SP-12 Link
from the Windows menu, a dialog such as the one illustrated below,
appears:

Thermometer
Area

Message
Area

From this point onwards, the Macintosh gets its orders (commands)
from the SP-12. Use the SP-12’s control panel to perform the
functions you require, as follows:

1. On the SP-12’s control panel, press the Cassette/Disk button to
activate that module.

2. Press “3”, followed by the number that corresponds to the
function you want to perform, then Enter. Although the functions
are printed on your SP-12’s control panel, they are listed again
for your reference:

1 = Save Sequences 6 = Load Sound #
2 = Save Sounds 7 = Verify Sequences
3 = Load Sequences 8 = Verify Sounds
4 = Load Segment # 9 = Catalog
5 = Load Sounds 0 = Format

As an example, to save sounds you would key in “32”, then
Enter.

Notice that the SP-12 treats the Macintosh just like a 1541 disk drive,
only considerably faster. All the SP-12’s Cassette/Disk operations
are the same when using the SP-12 Librarian as with the 1541 disk
drive, except that the first digit of each operation is a “3” instead of a
“2”.

SP-12 Command: 37 (Verify Sequences) & 38 (Verify Sounds)
Both of these commands read the contents of a file and compare it
with what is in the SP-12’s memory. The primary purpose of this is to
ensure that the data the SP-12 sent to the file has arrived intact.

The SP-12 Librarian automatically performs extensive data integrity
checks, so you probably won’t be using these two commands very
often.

SP-12 Command: 39 (Catalog)
The SP-12’s “Catalog” command is obsolete when you consider the
wealth of information available on the SP-12 Librarian. You probably
won’t use this command at all.

SP-12 Command: 30 (Format)
The SP-12’s “Format” command is obsolete when using the SP-12
Librarian, since files and disks can’t be formatted from the SP-12.
• If a floppy disk has never been formatted before (ie: it’s straight out

of the box), the Macintosh will format it for you when you put it in
the drive the first time.

• If you want to erase an entire disk, use The Finder’s Erase Disk
command.

• If you want to create a new file, use the SP-12 Librarian’s New
command in the File menu.

The SP-12 Link
The SP-12 Link dialog, as illustrated earlier on this page, has three
objects you should note:

• The Thermometer Area displays a thermometer whenever the
SP-12 is reading or writing a file. It is used to gauge the percentage
of completion for the operation, and is similar to the one you see in
The Finder when you copy files or disks.

• The Message Area displays messages and errors that result from
the commands issued by the SP-12. The Macintosh beeps you
when an error is detected. For a comprehensive list of errors, see
Messages And Errors later in this manual.

• The Cancel button is used to close the SP-12 Link, and conclude
the link between your SP-12 and the Macintosh. Cancel is usually
pressed when the SP-12 finishes reading or writing a file.
   However, you can press Cancel at any time to stop the current
SP-12 operation. If you do so, you will likely have to press the “No”
button on the SP-12’s “Master Control” module.

You can open and close the SP-12 Link window automatically by
setting the required Preferences. See the Edit menu’s Preferences
for more details.
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Using A Sound File

12SP-

The SP-12 Librarian’s sound files contain all the sample
data sent by the SP-12, as well as the names and
categories for each of the samples in that file.

Sound files can be opened by using the File menu’s Open
command. Each open sound file is represented by a single window
that can be viewed in two different ways, as illustrated below:

A typical sound file, shown with View Names

A typical sound file, shown with View All

View
A sound file’s view can be changed by using the Window menu’s
View Names command, or View All command. These commands
apply only to the active window, which must be a sound file. Each
sound file can have its own view. A check mark ( ) will appear to the
left of View Names or View All, depending on the way the window is
viewed.

Each sound file remembers the way it was displayed when you quit
the SP-12 Librarian or when the sound file is closed. The next time
you open that sound file, it will be displayed with the same view.

Identifying RAM Samples
The SP-12 has two different types of samples: RAM and ROM. RAM
samples (Random Access Memory), are the samples that are
changeable and are saved and loaded by the SP-12 Librarian. ROM
samples (Read-Only Memory) are always in the SP-12 and cannot
be changed or erased, such as the “Rim” and “Cowbell.”

A RAM sample can be played by any pad on the SP-12, even those
that normally have ROM samples. So a need arises to identify where
the samples are located. Below, is a bank of sounds as seen when a
sound file is in View Names.

Sample 
Flag

Wherever a RAM sample is stored, a “Sample Flag” (a dark
rectangle) appears to the right of the sample’s location. In the
example above, the following pads contain RAM samples: Bass 1,
Bass 2, Snare 1, and Snare 2. The remaining locations (El. Snare 1,
El. Snare 2, Rim, and Cowbell) retain their original ROM sounds.

Note: If you copy a RAM sample to another location and you don’t
delete the original sample, you will see two sample flags; one for the
original sample and one for the copy. The SP-12 is smart enough to
do this without consuming additional memory for the copied sound.

Sound File Changes
Changes made to a sound file by using the SP-12 Librarian
application are stored only within that file. They are not automatically
sent to the SP-12. For example, if you change a sound’s tuning value
on the sound window, the SP-12 must first load that sound (or the
entire sound file) before the change can be heard on the SP-12.

Naming Sounds
Sounds can be named in either view: View Names or View All. Use
standard Macintosh text editing rules to type and change names. The
one thing that differs from most other Macintosh applications is that
the SP-12 Librarian’s fields are “length limited.” This means the
Name field accepts a maximum of 30 characters, including spaces.

The RAM sample names will eventually be used to compile the
Sound Catalog, so be descriptive. Don’t bother naming ROM sounds
(those without a sample flag), since they play the sound that is
indicated by their location (ie: Bass 1).

For reasons of consistency, you should adopt standard conventions
for naming sounds, such as mixed case letters (“Hi-Hat”) or capitals
(“HI-HAT”).

Categorizing Sounds
Sounds can be categorized only when the window is in View All. Use
standard Macintosh text editing rules to type and change a sound’s
category. The one thing that differs from most other Macintosh
applications is that the SP-12 Librarian’s fields are “length limited.”
This means the Category field accepts a maximum of 12 characters,
including spaces.

The RAM sample’s categories will eventually be used to compile the
Sound Catalog, so be descriptive. Don’t bother categorizing ROM
sounds (those without a sample flag), since they will not appear in
the Sound Catalog.

Sample classification can be simplified by creating a list of standard
categories. This list is created by using the Catalog menu’s Define
Category command. Then, whenever you want to classify a sound,
place the insertion point in the correct category field and select the
Catalog menu’s Set Category command. Your list of standard
categories will appear and you can choose the appropriate category.
For more details, see Define Category and Set Category, both in the
Catalog menu.
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Output Channel Number
Each sound is directed to one of 8 audio output channels on the back
of the SP-12, as well as the “Mix” audio output. Each sound’s
channel number can be seen in the “Ch” column when a sound
window is in View All. If you click a sound’s channel column, a dialog
appears as illustrated below:

Field Pointer

Output Channel 
Number

The “Field Pointer” points to the sound’s original channel value. This
lets you see all the information for that sound, including its name and
category. To select another channel, click the appropriate channel
number, then click OK. Or you can double-click the appropriate
channel number.

Mix Level
Each sound has a relative volume level (a “Mix” value from 0 to 15)
which can be seen in the “Mix” column when a sound window is in
View All. If you click a sound’s mix column, a dialog appears as
illustrated below:

Field Pointer

Mix Level 
Value

The “Field Pointer” points to the sound’s original mix value. This lets
you see all the information for that sound, including its name and
category. Click the up arrow to increase the mix level, or the down
arrow to decrease it, then click OK.

Tune/Decay
Each sound can be either tuned or decayed, as indicated in the
“Tune/ Decay” column when a sound window is in View All. If you
click a sound’s Tune/Decay column, a dialog appears as illustrated
below:

Field Pointer

Tune/Decay 
Selection

Tune/Decay
Value

Tune/Decay
Range

The “Field Pointer” points to the sound’s Tune/Decay setting and
value. This lets you see all the information for that sound, including
its name and category.

The Tuned and Decayed buttons select whether a sound is going to
be tuned or decayed.

The “Tune/Decay Value” scroll bar is used to display and change the
Tune/Decay value for ROM sounds only. For tuned sounds, the
range is from 0 (lowest pitch) to 31 (highest pitch). For decayed
sounds, the range is from 0 (shortest decay) to 31 (longest decay).
Click the up arrow to increase the value, or the down arrow to
decrease it. When you are in the SP-12’s Performance module, and
you are in the Tune/Decay mode, the value you assign here will be
used as the slider’s “center-value.”

The Lo, Mid, and Hi buttons correspond to the Tune/Decay Range
settings in your SP-12. If you are working with a ROM sound, the Lo,
Mid, and Hi buttons have values of 8, 16, and 24 respectively.

✓ Tips…
• You can double-click radio buttons, such as one of the 8 output

channels, to mean “select this channel and OK.” It is equivalent to
clicking on the desired button, then clicking the OK button.
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Using A Sequence File

12SP-

The SP-12 Librarian’s sequence files contain all the song
and segment data sent by the SP-12, as well as the names
for each song and segment in that file.

Sequence files can be opened by using the File menu’s
Open command. Each open sequence file is represented by a single
window, as illustrated below:

The song and segment numbers correspond to the numbers used by
the SP-12 (00 to 99). Use standard Macintosh text editing rules to
type and change names. The one thing that differs from most other
Macintosh applications is that the SP-12 Librarian’s fields are “length
limited.” This means the Name field accepts a maximum of 60
characters, including spaces.

✓ Tips…
• You can use this window to make notes about your songs, synth

setups, or anything else. Just type in the required information in
unused song spaces.

• The section you are in (songs or segments) scrolls automatically if
you use Tab, or Shift-Tab.
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Using The Sound Catalog
The Sound Catalog is a list of sample names compiled from
various sound files. It does not contain the sample data
itself, only the sample names (RAM samples only). You can
think of the Sound Catalog as an index to your sample
library.

The Sound Catalog can be opened by using the Catalog menu’s
Show Catalog command. The sound catalog can be sorted in two
different ways, as illustrated below:

The Sound Catalog: Sort By File

The Sound Catalog: Sort By Category

Sorting
The Sound Catalog can be sorted in two different ways. Sort By File
(in the Catalog menu) is used to sort the sounds by their sound file’s
name. Sort By Category (also in the Catalog menu) is used to sort
the Sound Catalog by each sample’s category.

The Sound Catalog, when sorted by file, is best suited for
determining the contents of each sound file. When sorted by
category, it is best suited for finding a particular type of sample. For
instance, all the “Snare” samples would be grouped together,
indicating where each sample can be found.

In the Catalog menu, a check mark ( ) will appear to the left of Sort
By File or Sort By Category, depending on how the catalog is sorted.
The Sound Catalog must be the active window to change the way it
is sorted.

The Sound Catalog remembers the way it was sorted when you quit
the SP-12 Librarian, or when the Sound Catalog is closed. The next
time you open the Sound Catalog, it will be sorted the same way.

Adding To The Sound Catalog
The information in a sound file can be added to the Sound Catalog
by using the Catalog menu’s Add Sounds To Catalog command
(read the related material, if necessary).

Deleting Sounds From The Sound Catalog
You can delete sounds from the Sound Catalog by dragging them to
the trash can icon located above the right scroll bar. As your pointer
moves onto a sound, it changes from a pointer to a hand. As you
click and hold the mouse button, a dotted outline appears around the
sound. Drag the hand onto the trash can (the trash can becomes
selected), and release the mouse button. The sound is deleted from
the Sound Catalog.

Please note that you can’t “undo” this process. If you want to put the
sound back into the catalog, add the sound file as described above in
“Adding To The Sound Catalog.”

Changing The Sound Catalog
The only changes you can make to a Sound Catalog are adding
sounds or deleting sounds. Here a few examples of how typical
changes would be made.

If you renamed a sound file’s file name:
1. Activate the Sound Catalog by selecting the Catalog menu’s

Show Catalog command.
2. Select Sort By File from the Catalog menu. This will group

sounds from the same sound file in one place.
3. Drag the sounds that use the old file name out of the window to

delete them.
4. Open the new sound file if necessary, and activate it (ie: make

sure its the front window)
5. Use the Catalog menu’s Add Sounds To Catalog command.

The Sound Catalog is now updated with the new file’s sample
information.

If you changed other information in a sound window:
1. Open the new sound file if necessary, and activate it (ie: make

sure its the front window)
2. Use the Catalog menu’s Add Sounds To Catalog command.
3. The SP-12 Librarian asks you:

Replace existing “File Name” sounds in the catalog?
Click the Yes button. The old Sound Catalog entries
representing the active sound file will be replaced with the
newest information.

✓ Tips…
• If a sample has been copied to another location and the original

sample has not been deleted, both the sound window and the
Sound Catalog will consider those to be two samples.

• When the Sound Catalog is printed, it provides a sample count per
file, per category, and for the whole catalog. This excludes copies
of samples within the same file (as described above).

• When the Sound Catalog is printed, it provides a “Total Sample
Time” figure per file, per category, and for the whole catalog. This
excludes copies of samples within the same file (as described
above).
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Behind The Scenes
This section gives you a little background on how the SP-12 Librarian
does its magic, as well as providing technical information for those
who are interested.

“Fail Safe” File Management
Whenever the SP-12 saves sounds or sequences to an existing
sound or sequence file, the SP-12 Librarian takes an additional step
to ensure that the original data is not erased until a valid replacement
has been obtained.

The following is done automatically when you update an existing
sound or sequence file with new SP-12 data:
• The SP-12 Librarian tries to create a temporary work file on the

same disk as the original file. The work file is about 192K for sound
files, and 49K for sequence files. If there is not enough room on
that disk, it tries to create the work file on the startup disk. If it can’t
find enough room on the startup disk, a “Disk is full” error occurs
and the process is canceled.

• The SP-12’s data is saved in the work file. If any problem occurs,
such as a faulty disk or aborting the operation by pressing “No” on
the SP-12, the operation is halted. Your original file is still intact.

• After the SP-12 has completed writing its data to the work file, the
work file is copied into the original file, thereby replacing the old
data with the newest SP-12 data. If any problem occurs during the
copying, the original file’s data will be corrupt and the work file will
contain the SP-12’s newest information. A dialog will inform you of
this. In this case, the work file will be called “SP-12 Librarian #x”
(where x is a number from 1 to 99).

• If all goes well, the work file is deleted.

The Fail Safe File Management system does have a drawback. If you
don’t have a hard disk and there is insufficient room on either floppy
for a work file, SP-12 Librarian will not let you save the SP-12’s
information. You can get around this by saving your file on another
disk, then copying it to the correct floppy using The Finder.

MIDI Problems
The SP-12 Librarian automatically checks all its incoming MIDI data
for invalid commands and data. Furthermore, it verifies the files it
generates to make sure they contain what they’re supposed to.

The only thing the SP-12 Librarian can’t automatically check is MIDI
data that has been corrupted while in transit between the SP-12 and
the Macintosh. This problem can be attributed to either physical
damage (bad MIDI cables or connections) or electromagnetic
interference. Observe these general rules to reduce the likelihood of
MIDI data errors:
• Keep your MIDI cables away from AC power lines and sources of

strong Radio Frequency Interference (RFI), such as the left side
and upper-left corner of compact Macintoshes like the 512KE,
Plus, SE, SE/30, Classic, Classic II, Color Classic, etc.

• Try to keep your MIDI cables relatively short (about 6 feet long).
• Don’t step on your cables, MIDI or otherwise. This shortens their

life considerably.
In actual tests, we found that 10-foot premium quality MIDI cables
never failed us. Once you establish a fixed MIDI setup and get the
glitches out, you probably won’t bother to verify your SP-12’s sound
or sequence files.

Software Pirates
Many music-related applications use copy-protection schemes to
discourage software pirates. Unfortunately, this also complicates life
for legitimate owners in a variety of ways.

Water's Edge Software creates software with no copy-protection.
This is done for one reason only: to let legitimate licensees use our
software products more easily.

We give you an excellent value by combining quality software with
comprehensive documentation, all for a very reasonable price. We
think this is a fair way of doing business.

If you make illegal copies of this program, or if you accept a pirated
copy from someone else, you are jeopardizing the future of this
project and all projects that may follow. We just can’t provide this
service at a financial loss!

Vote with your dollars… If someone’s software is good enough for you
to use, it’s good enough to be used fairly. Please, don’t pirate
programs.

Author
The SP-12 Librarian was designed and created by Steve Makohin.

We thank the people at E-mu Systems for their help. Special thanks
to Les Titze for his technical assistance and his useful suggestions.

The Manual
The SP-12 Librarian User’s Manual was designed and written by
Steve Makohin on a Macintosh using:
• Microsoft Word™ 5.1a word processor for text and layout
• Claris MacPaint™ for pictures (screen snap-shots)
• Claris MacDraw™ for drawings

Each “SP-12 Librarian User’s Manual” is a laser printed original
document.

Programming
SP-12 Librarian is written using THINK Pascal™ to produce a
compact, fast executing program.

To reduce development time, we used the “Standard Utilities
Package,” a toolbox enhancer (by Water's Edge Software).

Machine language MIDI I/O routines from MidiPascal™ (by Altech
Systems) are used to communicate with the Macintosh’s MIDI
interface.
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Messages And Errors
This section lists all the messages and errors you may encounter in
the SP-12 Librarian. You will never see a majority of them. Use this
section as a reference only.

The only difference between a message and an error, is that an error
indicates that something has gone wrong. The Macintosh will beep
you when an error is reported. A message, on the other hand, just
tells you what is going on.

The messages and errors are listed in alphabetic order. They all
follow a similar format, as illustrated below:

This is the error for “file name”.
This is what the error means, and what you should do about it.

The bold line provides an example of the error as it appears on the
Macintosh. Words in italics (such as “file name”) indicate that some
other text will be in its place. In this example, it will be replaced with
the name of a file. The body of the succeeding paragraph explains
the meaning of the message and what should be done about it.

The SP-12 Link dialog displays its own messages, most of which are
status messages such as “Reading sounds.” These messages are
also listed here, even if they are redundant.

For those of you with partitioned hard disks, the SP-12 Librarian sees
partitions as individual disks. So a “Disk is full” error means that a
partition may be full.

“File Name” can’t be saved because the file was moved or renamed.
The file, whose name is indicated by File Name, can not be saved
because the file has been renamed or moved to another folder while the
SP-12 Librarian was using it. This can occur only when using MultiFinder
or System 7.
You can avoid this problem by not renaming files or moving them to
another folder while they are opened by the SP-12 Librarian.
If the offending file is either a Sound or Sequence file, you can use the
File menu’s Save As command to save the information, if you wish.

“File Name” could not be created. Disk is full.
The file, whose name is indicated by File Name, could not be created
because the disk is full, or there is not enough space available on that disk
to create the required file.
Create the file on another disk.

“File Name” could not be created. Disk is locked.
The file, whose name is indicated by File Name, could not be created
because the disk is software locked.
Some other process has locked the required disk. This is possible if you
are using MultiFinder or System 7 or a Macintosh (not MIDI) network.
Create the file on an unlocked disk, or quit the other applications in
MultiFinder or System 7 and repeat the process.

“File Name” could not be created. Disk is write protected.
The file, whose name is indicated by File Name, could not be created
because the disk is write protected.
If a floppy disk is write protected, first eject the disk then slide the write-
protect tab on its back so that you can’t see light through it. If a hard disk
is write protected, consult your hard disk’s manual.

“File Name” could not be created. File directory full.
The file, whose name is indicated by File Name, could not be created
because there are too many files in that folder or disk. This error refers to
the number of files, not their size.
Create the file in another folder, or use another disk.

“File Name” could not be created. I/O error.
The file, whose name is indicated by File Name, could not be created
because a serious disk error has occurred. Your disk, or disk drive could
be damaged.
Quit the SP-12 Librarian and restart the Macintosh. Try the same
operation again. If you can’t reproduce the problem, it was probably just a
temporary glitch. Keep your guard up in case it happens again.
If you do reproduce the problem, or if it comes up again at another time,
suspect the disk first. For floppy disks, use The Finder to copy valid files to
another floppy. Don’t back up the floppy, since you may back up the fault
with it. Discard the bad floppy disk. With hard disks, remove all your valid
data, re-format the hard disk, then copy your files back onto the hard disk.
If the problem persists on a specific drive, have it checked out by a service
technician.

“File Name” could not be deleted. Disk is locked.
The file, whose name is indicated by File Name, could not be deleted
because the disk is software locked.
Some other process has locked the required disk. This is possible if you
are using MultiFinder or System 7 or a Macintosh (not MIDI) network. Quit
the other applications in MultiFinder or System 7 and repeat the process.

“File Name” could not be deleted. Disk is write protected.
The file, whose name is indicated by File Name, could not be deleted
because the disk is write protected.
If a floppy disk is write protected, first eject the disk then slide the write-
protect tab on its back so that you can’t see light through it. If a hard disk
is write protected, consult your hard disk’s manual.

“File Name” could not be deleted. File is busy.
The file, whose name is indicated by File Name, could not be deleted
because the file is open and in use. For example, you may be trying to
save a sound file as “Sounds 2” when “Sounds 2” already exists and is
open.
If the SP-12 Librarian is using the required file, close it. If you are using
MultiFinder or System 7, close the file from the application that is using it.
If you are sure the file is not busy, quit the SP-12 Librarian and restart
your Macintosh, then try the operation again.

“File Name” could not be deleted. File is locked.
The file, whose name is indicated by File Name, could not be deleted
because the file is locked.
Quit the SP-12 Librarian. In The Finder, click the locked file and select Get
Info in the File menu. Click the “Locked” box to remove the “X”, thereby
unlocking the file. The file is now unlocked.

“File Name” could not be deleted. I/O error.
The file, whose name is indicated by File Name, could not be deleted
because a serious disk error has occurred. Your disk, or disk drive could
be damaged.
Quit the SP-12 Librarian and restart the Macintosh. Try the same
operation again. If you can’t reproduce the problem, it was probably just a
temporary glitch. Keep your guard up in case it happens again.
If you do reproduce the problem, or if it comes up again at another time,
suspect the disk first. For floppy disks, use The Finder to copy valid files to
another floppy. Don’t back up the floppy, since you may back up the fault
with it. Discard the bad floppy disk. With hard disks, remove all your valid
data, re-format the hard disk, then copy your files back onto the hard disk.
If the problem persists on a specific drive, have it checked out by a service
technician.

“File Name” could not be opened. Disk is locked.
The file, whose name is indicated by File Name, could not be opened
because the disk is software locked.
Some other process has locked the required disk. This is possible if you
are using MultiFinder or System 7 or a Macintosh (not MIDI) network. Quit
the other applications in MultiFinder or System 7 and repeat the process.

“File Name” could not be opened. File is busy.
The file, whose name is indicated by File Name, could not be opened
because it is being used by another application.
If you are using MultiFinder or System 7, close the file from the application
that is using it. If you are sure the file is not busy, quit the SP-12 Librarian
and restart your Macintosh, then try the operation again.
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“File Name” could not be opened. File version can't be read by this
application.
The file, whose name is indicated by File Name, could not be opened
because it was created by a newer version of the SP-12 Librarian. This
error is a result of creating or updating a file with a newer version of the
SP-12 Librarian, then using an older version of the librarian.
If you are sure that you have not somehow reverted to using an older
version of the SP-12 Librarian, then the file in question has somehow
been damaged.

“File Name” could not be opened. I/O error.
The file, whose name is indicated by File Name, could not be opened
because a serious disk error has occurred. Your disk, or disk drive could
be damaged.
Quit the SP-12 Librarian and restart the Macintosh. Try the same
operation again. If you can’t reproduce the problem, it was probably just a
temporary glitch. Keep your guard up in case it happens again.
If you do reproduce the problem, or if it comes up again at another time,
suspect the disk first. For floppy disks, use The Finder to copy valid files to
another floppy. Don’t back up the floppy, since you may back up the fault
with it. Discard the bad floppy disk. With hard disks, remove all your valid
data, re-format the hard disk, then copy your files back onto the hard disk.
If the problem persists on a specific drive, have it checked out by a service
technician.

“File Name” could not be opened. Only one catalog can be open at a time.
The Sound Catalog, whose name is indicated by File Name, could not be
opened because only one Sound Catalog can be open at a time.
If you are maintaining several versions of the Sound Catalog, close the old
Sound Catalog before opening the new one.

“File Name” could not be saved. Disk is full.
The file, whose name is indicated by File Name, could not be saved
because the disk is full, or there is not enough space available on that disk
to save the required file.
Use the File menu’s Save As command to save the file on another disk.
If the file is your Sound Catalog, quit the SP-12 Librarian and copy the
catalog to another (blank) disk, then delete the original catalog. You will
then have to update the catalog with the sound files that were added to
the catalog since the last time the catalog was saved.

“File Name” could not be saved. Disk is locked.
The file, whose name is indicated by File Name, could not be saved
because the disk is software locked.
Some other process has locked the required disk. This is possible if you
are using MultiFinder or System 7 or a Macintosh (not MIDI) network.
Save the file on an unlocked disk using the File menu’s Save As
command, or quit the other applications in MultiFinder or System 7 and
repeat the process.

“File Name” could not be saved. Disk is write protected.
The file, whose name is indicated by File Name, could not be saved
because the disk is write protected.
If a floppy disk is write protected, first eject the disk then slide the write-
protect tab on its back so that you can’t see light through it. If a hard disk
is write protected, consult your hard disk’s manual.

“File Name” could not be saved. File is locked.
The file, whose name is indicated by File Name, could not be saved
because the file is locked.
First, use the File menu’s Save As command to save your information
using another file name, then quit the SP-12 Librarian. In The Finder, click
the locked file and select Get Info in the File menu. Click the “Locked” box
to remove the “X”, thereby unlocking the file. The file is now unlocked. You
might as well delete it, since your information was saved in another file.

“File Name” could not be saved. I/O error.
The file, whose name is indicated by File Name, could not be saved
because a serious disk error has occurred. Your disk, or disk drive could
be damaged.
Try the same operation again. If you can’t reproduce the problem, it was
probably just a temporary glitch. Keep your guard up in case it happens
again.
If you do reproduce the problem, or if it comes up again at another time,
suspect the disk first. Try to use the File menu’s Save As command to
save your information using a different file name or on another disk, then
quit the SP-12 Librarian.
For floppy disks, use The Finder to copy valid files to another floppy. Don’t
back up the floppy, since you may back up the fault with it. Discard the
bad floppy disk. With hard disks, remove all your valid data, re-format the
hard disk, then copy your files back onto the hard disk.
If the problem persists on a specific drive, have it checked out by a service
technician.

An open file is using this name.
The name you specified can’t be used because the SP-12 Librarian
already has a file opened using the same name. Use another file name.

Can't add sounds to catalog. No samples in this file.
The Add Sounds To Catalog command could not do anything because
there are no RAM samples in the active window. At least 1 sample must
exist in a sound file for it to be added to the Sound Catalog.

Can't create work file -- All names used.
A work file can’t be created because all possible work file names already
exist as files on that disk.
Quit the SP-12 Librarian and return to The Finder. Check the disk
containing the file that you wanted to update for a file named “SP-12
Librarian #1”. If you renamed the SP-12 Librarian program, the name
SP-12 Librarian will be replaced by the program’s name. Remove that file
by dragging it to the trash. Do the same for files named “SP-12 Librarian
#2” through “SP-12 Librarian #99”, since these are all work files that can
be removed. Note that the work files may be on your startup disk.

Can't find “SP-12 Catalog” file. Do you want to look  for it, or create a new
Catalog?
The SP-12 Librarian can’t find the Sound Catalog file, and needs to know
if you want to search for it, or create a new one (Find and New buttons will
be available.)
Read the section in Using The SP-12 Librarian that applies to the
operation you just attempted: Show Catalog or Add Sounds To Catalog.

Can't read blank or damaged file.
The SP-12 can’t read a file that is blank or damaged. It can only read a
sound file or sequence file.

Can't save sequences in a sound file.
The SP-12 can’t save sequence data in a sound file. Sequence data can
only be saved in a sequence file, a blank file, or a damaged file.

Can't save sounds in a sequence file.
The SP-12 can’t save sound data in a sequence file. Sound data can only
be saved in a sound file, a blank file, or a damaged file.

Cassette/Disk
Write Protected

This message appears only on the SP-12’s control panel. It indicates that
the SP-12’s data can't be written to the file for one or more of the following
reasons:
(1) The file is locked: If this is the case, quit the SP-12 Librarian. In The
Finder, click the locked file and select Get Info in the File menu. Click the
“Locked” box to remove the “X”, thereby unlocking the file. The file is now
unlocked.
(2) The disk is write protected: If a floppy disk is write protected, first eject
the disk then slide the write-protect tab on its back so that you can’t see
light through it. If a hard disk is write protected, consult your hard disk’s
manual.
(3) The disk is locked: Some other process has locked the required disk.
This is possible if you are using MultiFinder or System 7 or a Macintosh
(not MIDI) network. Create a new file on an unlocked disk, or quit the
other applications in MultiFinder or System 7 and repeat the process.

Cassette/Disk
DataRead Error

This message appears only on the SP-12’s control panel. The SP-12
Librarian has had a problem, the nature of which is described in the
“SP-12 Link” window. This message is also displayed if the SP-12
operation is halted by pressing “No” on the SP-12, or clicking the SP-12
Librarian’s Cancel button.
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Cassette/Disk
NoDisk Connected

This message appears only on the SP-12’s control panel. The SP-12 is
not communicating with the SP-12 Librarian. Make sure your MIDI network
is set up as described on page 2, check the MIDI cables, make sure the
SP-12 Librarian application is running, make sure that the relevant file is
open on the Macintosh and that the “SP-12 Link” window is open.
If you are running a low-end Macintosh, such as a Macintosh Plus with
only floppy disks, then you may have problems having the SP-12 Link
open automatically when a command is entered at the SP-12 (see
Preferences). When you enter a command at the SP-12’s control panel, it
sends a “disk status” command to the SP-12 Librarian. If the librarian does
not open the link and return a status to the SP-12 quickly enough, then the
SP-12 assumes that no disk is connected. If this happens, re-try the
command at the SP-12’s control panel and the link will be established.

Changes made to Categories were not saved because the “SP-12 Librarian”
application was moved or renamed

Changes made to Preferences were not saved because the “SP-12 Librarian”
application was moved or renamed

Changes made to Preferences and Categories were not saved because the
“SP-12 Librarian” application was moved or renamed.
Changes made to the Preferences settings and/or the Categories List
were not saved because the SP-12 Librarian application was renamed or
moved to another folder while it was running. This can occur only when
using MultiFinder or System 7.
You can avoid this problem by not renaming or moving the SP-12
Librarian to another folder while it is running.

Checking disk status.
The SP-12 Librarian is checking the active window’s file and the disk on
which it is located. This information is passed back to the SP-12.

Disk cannot be formatted from the SP-12.
SP-12 command “30” (format disk) was issued from the SP-12. The
SP-12 Librarian does not accept this command. If you want to create a
new file, use the File menu’s New command.

Disk is full -- No room for work file.
An existing sound file or sequence file can’t be update because there is
not enough available space to create a work file. This process is explained
under “Fail Safe” File Management in the Behind The Scenes chapter.

You can get around this problem by copying the required file to a blank
disk. Update that copy with the SP-12’s data, then move the copy back to
the original disk.

Disk is full! Save songs on another disk.
The disk was filled while saving sequence data in a blank or damaged file.
The file is now considered damaged and contains no valid data (although
it may occupy a fair amount of space on the disk).
Save your song data on another disk, then quit the SP-12 Librarian and
delete the damaged file.

Disk is full! Save sounds on another disk.
The disk was filled while saving sound data in a blank or damaged file.
The file is now considered damaged and contains no valid data (although
it may occupy a fair amount of space on the disk).
Save your sound data on another disk, then quit the SP-12 Librarian and
delete the damaged file.

Disk is full. Please save “File Name” on a different disk.
The file, whose name is indicated by ”File Name”, could not be saved
because the disk is full. Save the file on another disk using the File
menu’s Save As command.

File name can't contain a colon (:)
Do not use a colon (:) when entering a file name.

File name must be between 1 and 31 characters long.
The file name you entered exceeded 31 characters in length. A file name
must be from 1 to 31 characters long, including spaces.

Insufficient memory to add new category.
There is not enough memory available to create a new sound category.
This problem will occur only when memory is severely limited.
Close any open desk accessories and try again. If this doesn’t work, quit
the SP-12 Librarian. If you are not using MultiFinder or System 7 and disk
caching is on, turn it off (via the Control Panel desk accessory). If you are
using MultiFinder or System 7, allocate more memory to the SP-12
Librarian, restart the SP-12 Librarian, and try the operation again.

Insufficient memory to add new category. Try closing a window first.
There is not enough memory available to create a new sound category.
This problem will occur only when memory is severely limited.
Close any open desk accessories. If possible, close a document window
that you do not immediately require and try the operation again. If you get
the same problem, quit the SP-12 Librarian. If you are not using
MultiFinder or System 7 and disk caching is on, turn it off (via the Control
Panel desk accessory). If you are using MultiFinder or System 7, allocate
more memory to the SP-12 Librarian, restart the SP-12 Librarian, and try
the operation again.

Insufficient memory to add sounds to catalog.
There is not enough memory available to add the active sound file to the
Sound Catalog. This problem will occur only when memory is severely
limited.
Close any open desk accessories and try again. If this doesn’t work, quit
the SP-12 Librarian. If you are not using MultiFinder or System 7 and disk
caching is on, turn it off (via the Control Panel desk accessory). If you are
using MultiFinder or System 7, allocate more memory to the SP-12
Librarian, restart the SP-12 Librarian, and try the operation again.

Insufficient memory to add sounds to catalog. Try closing a window first.
There is not enough memory available to add the active sound file to the
Sound Catalog. This problem will occur only when memory is severely
limited.
Close any open desk accessories. If possible, close a document window
that you do not immediately require and try the operation again. If you get
the same problem, quit the SP-12 Librarian. If you are not using
MultiFinder or System 7 and disk caching is on, turn it off (via the Control
Panel desk accessory). If you are using MultiFinder or System 7, allocate
more memory to the SP-12 Librarian, restart the SP-12 Librarian, and try
the operation again.

Insufficient memory to complete operation.
There is not enough memory available to complete the required operation.
This problem will occur only when memory is severely limited.
Close any open desk accessories and try again. If this doesn’t work, quit
the SP-12 Librarian. If you are not using MultiFinder or System 7 and disk
caching is on, turn it off (via the Control Panel desk accessory). If you are
using MultiFinder or System 7, allocate more memory to the SP-12
Librarian, restart the SP-12 Librarian, and try the operation again.

Insufficient memory to complete operation. Try closing a window first.
There is not enough memory available to complete the required operation.
This problem will occur only when memory is severely limited.
Close any open desk accessories. If possible, close a document window
that you do not immediately require and try the operation again. If you get
the same problem, quit the SP-12 Librarian. If you are not using
MultiFinder or System 7 and disk caching is on, turn it off (via the Control
Panel desk accessory). If you are using MultiFinder or System 7, allocate
more memory to the SP-12 Librarian, restart the SP-12 Librarian, and try
the operation again.

Insufficient memory to link with the SP-12.
There is not enough memory available to establish the SP-12 Link. This
problem will occur only when memory is severely limited.
Close any open desk accessories and try again. If this doesn’t work, quit
the SP-12 Librarian. If you are not using MultiFinder or System 7 and disk
caching is on, turn it off (via the Control Panel desk accessory). If you are
using MultiFinder or System 7, allocate more memory to the SP-12
Librarian, restart the SP-12 Librarian, and try the operation again.

Insufficient memory to link with the SP-12. Try closing a window first.
There is not enough memory available to establish the SP-12 Link. This
problem will occur only when memory is severely limited.
Close any open desk accessories. If possible, close a document window
that you do not immediately require and try the operation again. If you get
the same problem, quit the SP-12 Librarian. If you are not using
MultiFinder or System 7 and disk caching is on, turn it off (via the Control
Panel desk accessory). If you are using MultiFinder or System 7, allocate
more memory to the SP-12 Librarian, restart the SP-12 Librarian, and try
the operation again.
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Insufficient memory to open “File Name”.
There is not enough memory available to open the file whose name is
indicated by File Name. This problem will occur only when memory is
severely limited.
Close any open desk accessories and try again. If this doesn’t work, quit
the SP-12 Librarian. If you are not using MultiFinder or System 7 and disk
caching is on, turn it off (via the Control Panel desk accessory). If you are
using MultiFinder or System 7, allocate more memory to the SP-12
Librarian, restart the SP-12 Librarian, and try the operation again.

Insufficient memory to open “File Name”. Try closing a window first.
There is not enough memory available to open the file whose name is
indicated by File Name. This problem will occur only when memory is
severely limited.
Close any open desk accessories. If possible, close a document window
that you do not immediately require and try the operation again. If you get
the same problem, quit the SP-12 Librarian. If you are not using
MultiFinder or System 7 and disk caching is on, turn it off (via the Control
Panel desk accessory). If you are using MultiFinder or System 7, allocate
more memory to the SP-12 Librarian, restart the SP-12 Librarian, and try
the operation again.

Insufficient memory to run this application.
There is not enough memory available to run the SP-12 Librarian. This
problem will occur only when memory is severely limited.
Quit the SP-12 Librarian. If you are not using MultiFinder or System 7 and
disk caching is on, turn it off (via the Control Panel desk accessory). If you
are using MultiFinder or System 7, allocate more memory to the SP-12
Librarian, restart the SP-12 Librarian, and try running the SP-12 Librarian
again.

Not enough room on “Disk Name” to save the changed list of categories.
The category list (which is maintained by using the Catalog menu’s Define
Category command) could not be saved on the disk whose name is
indicated by Disk Name.
The category list is saved as part of the SP-12 Librarian application, so
this error indicates that the disk containing the SP-12 Librarian is full. If
the SP-12 Librarian is on a floppy disk, try to remove unnecessary files,
fonts, and desk accessories.

Operation was terminated. Disk is full.
The current SP-12 operation could not be completed because the disk is
full.
Save your SP-12’s data on another disk, preferably a blank one.

Operation was terminated. Disk is locked.
The current SP-12 operation could not be completed because the disk is
software locked.
Some other process has locked the required disk. This is possible if you
are using MultiFinder or System 7 or a Macintosh (not MIDI) network.
Unlock the disk, or quit the other applications in MultiFinder or System 7
and repeat the process.

Operation was terminated. Disk is write protected.
The current SP-12 operation could not be completed because the disk is
write protected.
If a floppy disk is write protected, first eject the disk then slide the write-
protect tab on its back so that you can’t see light through it. If a hard disk
is write protected, consult your hard disk’s manual.

Operation was terminated. File is locked.
The current SP-12 operation could not be completed because the file is
locked.
Quit the SP-12 Librarian. In The Finder, click the locked file and select Get
Info in the File menu. Click the “Locked” box to remove the “X”, thereby
unlocking the file. The file is now unlocked.

Operation was terminated. I/O error.
The current SP-12 operation could not be completed because a serious
disk error has occurred. Your disk, or disk drive could be damaged.
Quit the SP-12 Librarian and restart the Macintosh. Try the same
operation again. If you can’t reproduce the problem, it was probably just a
temporary glitch. Keep your guard up in case it happens again.
If you do reproduce the problem, or if it comes up again at another time,
suspect the disk first. For floppy disks, use The Finder to copy valid files to
another floppy. Don’t back up the floppy, since you may back up the fault
with it. Discard the bad floppy disk. With hard disks, remove all your valid
data, re-format the hard disk, then copy your files back onto the hard disk.
If the problem persists on a specific drive, have it checked out by a service
technician.

Printer file is missing. Use the Chooser to select a printer.
Use the Apple menu’s Chooser to select a printer. If the Chooser does not
display a printer, you will have to move a copy of a printer file (such as an
ImageWriter) into your System folder.

Printing error has occurred (Can't save spool file)
A document can’t be printed because a spool file can’t be saved on the
startup disk. Quit the SP-12 Librarian and restart your Macintosh.

Printing error has occurred (Disk is full)
A document can’t be printed because your startup disk is full. You need
about 15K of free space on your startup disk to print a document. Try to
remove unnecessary files, fonts and desk accessories from your startup
disk.

Printing error has occurred (File directory full)
A document can’t be printed because there are too many files in your
System folder and/or your startup disk. This error refers to the number of
files, and not their size. Try to remove unnecessary files from your startup
disk.

Printing error has occurred (I/O error)
A document can’t be printed because a serious disk error has occurred on
your startup disk. Your disk, or disk drive could be damaged.
Quit the SP-12 Librarian and restart the Macintosh. Try the same
operation again. If you can’t reproduce the problem, it was probably just a
temporary glitch. Keep your guard up in case it happens again.
If you do reproduce the problem, or if it comes up again at another time,
suspect the disk first. For floppy disks, use The Finder to copy valid files to
another floppy. Don’t back up the floppy, since you may back up the fault
with it. Discard the bad floppy disk. With hard disks, remove all your valid
data, re-format the hard disk, then copy your files back onto the hard disk.
If the problem persists on a specific drive, have it checked out by a service
technician.

Printing error has occurred (ID=x)
A document can’t be printed because an internal error has occurred
(identified by the x). This error number will mean nothing to you, however,
an Apple dealer may be able to help you. If not, contact Water's Edge
Software.

Printing error has occurred (Out of memory)
A document can’t be printed because there is not enough memory
available. This problem will occur only when memory is severely limited.
Quit the SP-12 Librarian. If you are not using MultiFinder or System 7 and
disk caching is on, turn it off (via the Control Panel desk accessory). If you
are using MultiFinder or System 7, allocate more memory to the SP-12
Librarian, restart the SP-12 Librarian, and try the operation again. If it
occurs again, close unnecessary windows (and desk accessories) while
printing.

Process was halted by SP-12.
The current SP-12 process was halted by the SP-12. This message is
displayed if you abort an operation by pressing “No” on the SP-12’s
control panel, or if the SP-12 determines that the process should be
halted.
An example of this is when the SP-12 wants to write to a file that is locked.
The SP-12’s display will read “Write protected.”

Reading songs.
The SP-12 is busy reading a sequence file from the Macintosh. The
SP-12 could be loading the entire file, verifying the file, or loading
individual segments, depending on which command was entered into the
SP-12.

Reading sounds.
The SP-12 is busy reading a sound file from the Macintosh. The SP-12
could be loading the entire file, verifying the file, or loading individual
sounds, depending on which command was entered into the SP-12.



Messages And Errors SP-12 Librarian User’s Manual

Page 22 Water’s Edge Software

Reading was terminated. I/O error.
The SP-12 had to stop reading the sound or song file because a serious
disk error has occurred. Your disk, or disk drive could be damaged.
Quit the SP-12 Librarian and restart the Macintosh. Try the same
operation again. If you can’t reproduce the problem, it was probably just a
temporary glitch. Keep your guard up in case it happens again.
If you do reproduce the problem, or if it comes up again at another time,
suspect the disk first. For floppy disks, use The Finder to copy valid files to
another floppy. Don’t back up the floppy, since you may back up the fault
with it. Discard the bad floppy disk. With hard disks, remove all your valid
data, re-format the hard disk, then copy your files back onto the hard disk.
If the problem persists on a specific drive, have it checked out by a service
technician.

Replace existing “File Name” sounds in the catalog?
This message is displayed to warn you that existing entries in the Sound
Catalog are about to be replaced by new ones with the same file name.
Yes and No buttons let you make a choice. For more details, see the
Catalog menu’s Add Sounds To Catalog command.

Saving songs.
The SP-12 is busy saving its sound data to a file on the Macintosh.

Saving sounds.
The SP-12 is busy saving its sequence data to a file on the Macintosh.

Song file reading completed.
The SP-12 has completed reading a sequence file from the Macintosh. It
could have finished loading the entire file, verifying the file, or loading
individual segments, depending on which command was entered into the
SP-12.

Song file was saved in “File Name” work file.
The SP-12’s sequence data was too big to fit into the existing sequence
file, so it was saved in a work file whose name is indicated by File Name.
You should quit the SP-12 Librarian and locate the work file. It will be a
sequence file located on either the same disk and folder as the original
file, or on your startup disk. Delete your original sequence file, then
rename the work file and move it to the disk where your original file was
located.

Song file was saved.
The SP-12 Librarian has successfully completed saving the SP-12’s
sequence data in a Macintosh file.

Sound file reading completed.
The SP-12 is completed reading a sound file from the Macintosh. It could
have finished loading the entire file, verifying the file, or loading individual
sounds, depending on which command was entered into the SP-12.

Sound file was saved in “File Name” work file.
The SP-12’s sound data was too big to fit into the existing sequence file,
so it was saved in a work file whose name is indicated by File Name.
You should quit the SP-12 Librarian and locate the work file. It will be a
sound file located on either the same disk and folder as the original file, or
on your startup disk. Delete your original sound file, then rename the work
file and move it to the disk where your original file was located.

Sound file was saved.
The SP-12 Librarian has successfully completed saving the SP-12’s
sound data in a Macintosh file.

SP-12' s MIDI data was interrupted or is unreadable.
This error indicates that the MIDI data coming from the SP-12 was
interrupted, or it doesn’t make sense to the librarian.
Here are some potential causes:
• pressing “No” on the SP-12 control panel (aborting the operation)
• pressing the SP-12’s drum pads
• MIDI data from other keyboards or devices
• a bad connection on a MIDI cable
• a damaged MIDI cable
• EMI or RFI (Electromagnetic or Radio Frequency Interference)
• SP-12 malfunction
• Macintosh’s MIDI interface malfunction
The first three items are the most likely candidates. For more information,
read MIDI Problems in the “Behind The Scenes” section.
If you are using a Macintosh 512KE or a Macintosh Plus and you are
using floppy disks, then you may occasionally get this error when saving
sounds or sequences to a new file (because the floppy disks are so slow,
the Mac might miss some incoming MIDI data). If you do get this problem,
just try saving the information again.

Unlock the “Disk Name” disk.
The disk, whose name is indicated by Disk Name, must be unlocked. Quit
the SP-12 Librarian.
If a floppy disk is write protected, first eject the disk then slide the write-
protect tab on its back so that you can’t see light through it. If a hard disk
is write protected, consult your hard disk’s manual.

Unlock the “File Name” application and the “Disk Name” disk.
The file, whose name is indicated by File Name, and the disk whose name
is indicated by Disk Name, must both be unlocked. Quit the SP-12
Librarian.
In The Finder, click the locked file and select Get Info in the File menu.
Click the “Locked” box to remove the “X”, thereby unlocking the file. The
file is now unlocked.
If a floppy disk is write protected, first eject the disk then slide the write-
protect tab on its back so that you can’t see light through it. If a hard disk
is write protected, consult your hard disk’s manual.

Unlock the “File Name” application.
The SP-12 Librarian must be unlocked to operate. First, quit the SP-12
Librarian.
In The Finder, click the SP-12 Librarian icon and select Get Info in the File
menu. Click the “Locked” box to remove the “X”, thereby unlocking the file.
The SP-12 Librarian is now unlocked.

Waiting for commands from SP-12.
The SP-12 Librarian is waiting for commands from the SP-12 to tell it what
to do. Use the SP-12’s Cassette/Disk module to issue commands. Note,
however, that the first digit of each operation is a “3” instead of a “2”. See
the Windows menu’s SP-12 Link command for more detail.

Writing was terminated. I/O error.
The SP-12 had to stop writing the sound or song file because a serious
disk error has occurred. Your disk, or disk drive could be damaged.
Quit the SP-12 Librarian and restart the Macintosh. Try the same
operation again. If you can’t reproduce the problem, it was probably just a
temporary glitch. Keep your guard up in case it happens again.
If you do reproduce the problem, or if it comes up again at another time,
suspect the disk first. For floppy disks, use The Finder to copy valid files to
another floppy. Don’t back up the floppy, since you may back up the fault
with it. Discard the bad floppy disk. With hard disks, remove all your valid
data, re-format the hard disk, then copy your files back onto the hard disk.
If the problem persists on a specific drive, have it checked out by a service
technician.
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Software License Agreement &
Limited Warranty
This section is a copy of the Software License Agreement and
Limited Warranty, which are printed on the sealed disk package:

IMPORTANT! READ CAREFULLY BEFORE OPENING
THE SEALED DISK PACKAGE.

SOFTWARE LICENSE AND LIMITED WARRANTY
This legal document is an agreement between you, the end user, and

Water's Edge Software. BY OPENING THIS SEALED DISK PACKAGE, YOU
ARE AGREEING TO BECOME BOUND BY THE TERMS OF THIS
AGREEMENT, WHICH INCLUDES THE SOFTWARE LICENSE, LIMITED
WARRANTY, and ACKNOWLEDGMENT.

IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO
NOT OPEN THIS DISK PACKAGE. PROMPTLY RETURN THE UNOPENED
DISK PACKAGE AND THE OTHER ITEMS (INCLUDING WRITTEN
MATERIALS) WHICH ARE PART OF THIS PRODUCT, ALONG WITH
PROOF OF PURCHASE, TO THE PLACE WHERE YOU OBTAINED THEM
FOR A REFUND.

In order to preserve and protect its rights under applicable law, Water's
Edge Software does not sell any rights in its SOFTWARE. Rather, Water's
Edge Software grants the right to use its SOFTWARE by means of a
SOFTWARE LICENSE. Water's Edge Software specifically retains title to all
Water's Edge Software computer software.

SOFTWARE LICENSE
1. GRANT OF LICENSE. In consideration of payment of the License fee,

which is a part of the price you paid for this product, and your agreement to
abide by the terms and conditions of this License and the Limited Warranty,
Water's Edge Software, as Licensor, grants you, the Licensee, a non-
exclusive right to use and display this copy of a Water's Edge Software
program (hereinafter the “SOFTWARE”) on a single COMPUTER (i.e., with a
single CPU) at a single location so long as you comply with the terms of this
License. If the single computer on which you use the SOFTWARE is a multi-
user system, the License covers all users on that single system without
further License payments. Water's Edge Software reserves all rights not
expressly granted to the LICENSEE.

2. OWNERSHIP OF SOFTWARE. As the LICENSEE, you own the
magnetic disk or other physical media on which the SOFTWARE is originally
or subsequently recorded or fixed, but an express condition of this License is
that Water's Edge Software retains title and ownership of the SOFTWARE,
regardless of the form or media in or on which the original and other copies
may exist. This License is not a sale of the original SOFTWARE or any copy.

3. COPY RESTRICTIONS. This SOFTWARE is copyrighted. Unauthorized
copying of the SOFTWARE, including SOFTWARE that has been modified,
merged, or included with other software, is expressly forbidden. You may be
held legally responsible for any copyright infringement that is caused or
encouraged by your failure to abide by the terms of this License.

Subject to the restrictions above, you may make one (1) copy of the
SOFTWARE solely for backup purposes. You must reproduce and include the
copyright notice on the backup copy.

4. USE RESTRICTIONS. As the LICENSEE, you may physically transfer
the SOFTWARE from one computer to another, provided that the
SOFTWARE is used on only one computer at a time. You may not
electronically transfer the SOFTWARE from one computer to another over a
network. You may not distribute, or allow to be distributed, copies of the
SOFTWARE or accompanying written materials to others. You may not
modify, adapt, translate, reverse engineer, decompile, disassemble, or create
derivative works based on the SOFTWARE.

5. TRANSFER RESTRICTIONS. This SOFTWARE is licensed only to you,
the LICENSEE, and may not be transferred to anyone without the prior written
consent of Water's Edge Software. Any authorized transferee of the
SOFTWARE shall be bound by the terms and conditions of this License and
Limited Warranty. In no event may you transfer, assign, rent, lease, sell or
otherwise dispose of the SOFTWARE, on a temporary or permanent basis,
except as expressly provided herein.

6. TERMINATION. This License is effective until terminated. This License
will terminate automatically without notice from Water's Edge Software if you
fail to comply with any provision of the License. Upon termination you shall
destroy the written materials and all copies of the SOFTWARE, including
modified copies, if any.

7. UPDATE POLICY. Water's Edge Software may create, from time to time,
updated versions of the SOFTWARE. As its option, Water's Edge Software
will make such updates available to the LICENSEE and transferees who have
paid the update fee and returned the Registration Form to Water's Edge
Software.

8. MISCELLANEOUS. This License is governed by the laws of the
Province of Ontario and shall benefit Water's Edge Software, its successors
and assigns. LICENSEE consents to jurisdiction in the Provincial and Federal
courts located in the province of Ontario.

LIMITED WARRANTY
THIS SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS

(INCLUDING INSTRUCTIONS FOR USE) ARE PROVIDED “AS IS”
WITHOUT WARRANTY OF ANY KIND. FURTHER, WATER'S EDGE
SOFTWARE DOES NOT WARRANTY, GUARANTEE OR MAKE ANY
REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF USE,
OF THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF
CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR
OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND
PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IF THE
SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU (AND NOT
WATER'S EDGE SOFTWARE OR ITS DEALERS, DISTRIBUTORS,
AGENTS, OR EMPLOYEES), ASSUME THE ENTIRE COST OF ALL
NECESSARY SERVICING, REPAIR, OR CORRECTION.

Water's Edge Software warrants to the original LICENSEE that the disk(s)
on which the SOFTWARE is recorded is free from defects in materials and
workmanship under normal use and service for a period of ninety (90) days
from the date of delivery as evidenced by a copy of the receipt. Water's Edge
Software’ entire liability and your exclusive remedy as to the disk(s) shall be,
at Water's Edge Software’ option, either (a) return the purchase price or (b)
replacement of the disk which does not meet Water's Edge Software Limited
Warranty and which is returned to Water's Edge Software postage prepaid
with a copy of the original receipt. If failure of this disk has resulted from
accident, abuse, or misapplication, Water's Edge Software shall have no
responsibility to replace the disk or provide a refund. In the event of
replacement of the disk, the replacement disk will be warranted for the
remainder of the warranty period or thirty (30) days, whichever is the longer.

THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, STATUTORY OR OTHERWISE, INCLUDING
BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE THAT
IS MADE BY WATER'S EDGE SOFTWARE ON THIS PRODUCT.

NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY
WATER'S EDGE SOFTWARE, ITS DEALERS, DISTRIBUTORS, AGENTS
OR EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY
INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY
ON ANY SUCH INFORMATION OR ADVICE.

NEITHER WATER'S EDGE SOFTWARE, NOR ANYONE ELSE WHO HAS
BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF
THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, INDIRECT,
CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING DAMAGES
FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS
OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE
USE OR INABILITY TO USE SUCH PRODUCT EVEN IF WATER'S EDGE
SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

THIS WARRANTY GIVES YOU SPECIFIC RIGHTS. YOU MAY HAVE
OTHER RIGHTS WHICH VARY FROM PROVINCE TO PROVINCE AND
CERTAIN LIMITATIONS CONTAINED IN THIS WARRANTY MAY NOT
APPLY TO YOU. Water's Edge Software’ liability to you for actual damages
from any cause whatsoever, and regardless of the form (whether in contract,
tort (including negligence), product liability or otherwise), will be limited to $50.

IN THE EVENT OF ANY CONFLICT BETWEEN ANY PROVISION IN THIS
LIMITED WARRANTY AND ANY APPLICABLE PROVINCIAL LEGISLATION,
THE APPLICABLE PROVINCIAL LEGISLATION TAKES PRECEDENCE
OVER THE CONTRAVENING PROVISION.

The Limited Warranty is governed by the laws of the Province of Ontario
and shall benefit Water's Edge Software, its successors and assigns.

ACKNOWLEDGMENT
YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AND

LIMITED WARRANTY, UNDERSTAND THEM, AND AGREE TO BE BOUND
BY THEIR TERMS AND CONDITIONS. YOU ALSO AGREE THAT THE
EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES
AND SUPERSEDE ALL PROPOSALS OR PRIOR ORAL OR WRITTEN
AGREEMENTS, AND ANY OTHER COMMUNICATIONS BETWEEN THE
PARTIES RELATING TO THE SUBJECT MATTER OF THE LICENSE OR
LIMITED WARRANTY.

Should you have any questions concerning this License or this Limited
Warranty, or if you desire to contact Water's Edge Software for any reason,
please contact in writing:

Water's Edge Software
P.O. Box 70022
2441 Lakeshore Road West,
Oakville, Ontario
Canada, L6L 6M9.


